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Wstep teoretyczny do Active Directory 2017

Active Directory to Microsoft’'owa implementacja protokofu sieciowego warstwy aplikacji
LDAP (ang. Lightweight Directory Access Protocol). Protokét LDAP stosowany jest w tak zwanych
ustugach katalogowych. Ustuga katalogowa to nic innego jak obszerna, hierarchiczna baz danych,
zawierajgca informacje o uzytkownikach, grupach uzytkownikéw, komputerach, a takze zasobach
sieciowych, dziatajgcych w sieciach firmowych, gdzie pracujg serwery Microsoft’owe. To nic innego jak
zbiér informacji o uzytkownikach sieci, ich uprawnieniach do réznego rodzaju zasobéw, komputerach,
na jakich pracuja, konfiguracji tych komputeréw i tak dalej. Active Directory pozwala administratorom
sieci, centralnie, z poziomu jednego komputera (odpowiednio skonfigurowanego serwera) zarzadzac
catym zbiorem uzytkownikow w sieci, okresla¢ ich uprawnienia do zasobdéw sieciowych, a takze
konfigurowaé komputery, na ktdrych pracujg. To potezine narzedzie zdecydowania utatwia prace
administratora w sieciach, gdzie pracujg dziesigtki uzytkownikdw i komputeréw. Na cato$é ustug

zwigzanych z Active Directory sktada sie az pie¢ elementéw:

AD Domain Services.
AD Certificate Services.
AD Lightweight Directory Services.

AD Rights Management Services.

I e

AD Federation Services.

W ramach kursu zajmowa¢d sie bedziemy Ustugami Domenowymi Active Directory (ang. Active

Directory Domain Services).

Pojecia zwigzane z Active Directory:

» Magazyn danych - plik, przechowywany na dysku serwera, zawierajacy informacje o obiektach
ustugi katalogowej. Obiektem ustugi katalogowej moze by¢ uzytkownik, grupa, jednostka
organizacyjna czy tez komputer. Plik nosi nazwe NTDS.dit.

» Kontroler domeny - serwer, na ktérym zainstalowano Active Directory, przechowujgcy kopie
magazyny danych. Wyrdzni¢ mozemy kontrolery typu Global Catalog (katalog globalny), a
takze kontrolery tylko do odczytu - Read-Only Domain Controler oraz odczytu i zapisu —
Writeable Domain Controler.

> Domena — obszar sieci, ktéremu przydzielono okreslone mozliwosci oraz zasoby. W nigj
skupione s3 obiekty Active Directory, takie jak uzytkownicy, grupy, jednostki organizacyjne
oraz komputery dziatajgce w jej obrebie. Aby mozna byto domene utworzy¢, wymagany jest

przynajmniej jeden kontroler.
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Wstep teoretyczny do Active Directory 2017

>

>
>

Las - zbidr jednej lub tez wielu domen. Pierwsza domena, ktéra zostanie utworzona w lesie,
bedzie tak zwang domeng gtdéwna lasu, a caty las przyjmie nazwe takg jak domena gtéwna. Jesli
przyktadowo tworzymy nowa domene w nowym lesie i nazwiemy jg test.local to caty las
przyjmie taka nazwe.

Drzewo - jedna domena, albo kilka domen pracujacych pod tg samg przestrzenig nazw DNS.
Jednostka organizacyjna — to obiekt ustugi AD, pozwalajgcy na przechowywanie
uzytkownikéw, grup uzytkownikéw oraz komputery. Jednostkom organizacyjnym mozna

przypisywac poszczegdlne zasady grupy oraz delegowa¢ uprawnienia administracyjne.

szkola.local pracownial.szkola.local

Wymagania systemoéw klienckich korzystajgcych z Active Directory:

Kazdy komputer kliencki, z zainstalowanym systemem Windows (7, 8.1 oraz 10) moze

pracowac¢ w domenie pod dwoma warunkami:

>

musi by¢ w wersji przynajmniej Professional (moze by¢ w wersji Ultimate lub Enterprise),
zadnej z wersji Home do domeny nie podtaczymy,

oprécz licencji na sam system, do kazdego klienta nalezy dokupi¢ dodatkowg licencje
pozwalajgcg na korzystanie z zasobdw serwera. Licencja to nosi nazwe CAL (ang. Client Access
License). Wiecej na temat licencji CAL przeczytacie na tej stronie:

https://www.microsoft.com/pl-pl/Licensing/product-licensing/client-access-license.aspx
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Implementacja Active Directory 2017

Implementacja ustug katalogowych Active Directory na serwerach polega na zainstalowaniu
odpowiedniej ustugi. Ustuga nazywa sie Ustugi Domenowe Active Directory (Active Directory Domain
Services). Jesli to pierwsza nasza domena w lesie, to oprdcz instalacji samej ustugi, musimy jeszcze
promowac nasz serwer do roli kontrolera domeny. Caty proces instalacji zostat przeze mnie

przedstawiony na zamieszczonym wideo:

» Implementacja na Windows Server 2008R2:

https://www.youtube.com/watch?v=11uuOiuM8v0&feature=youtu.be&t=4m17s

» Implementacja na Windows Server 2012R2:

https://www.youtube.com/watch?v=11uuQiuM8v0&feature=youtu.be&t=10m15s

Po instalacji i wstepnej konfiguracji ustugi nalezy przytaczy¢é komputery klienckie do domeny,

proces dla poszczegdlnych systemdw rowniez zostat przedstawiony na wideo:

» Dodawanie klienta do domeny z Windows 7:

https://www.youtube.com/watch?v=11uuQiuM8v0&feature=youtu.be&t=15m22s

» Dodawanie klienta do domeny z Windows 10

https://www.youtube.com/watch?v=11uuQiuM8v0&feature=youtu.be&t=16m12s

Sieci Komputerowe - Windows Server #2 Strona 5


https://www.youtube.com/watch?v=I1uuOiuM8v0&feature=youtu.be&t=4m17s
https://www.youtube.com/watch?v=I1uuOiuM8v0&feature=youtu.be&t=10m15s
https://www.youtube.com/watch?v=I1uuOiuM8v0&feature=youtu.be&t=15m22s
https://www.youtube.com/watch?v=I1uuOiuM8v0&feature=youtu.be&t=16m12s

Zarzadzanie obiektami Active Directory 2017

Od momentu implementacji ustugi Active Directory oraz domeny, zarzadzanie uzytkownikami
i grupami odbywa sie poprzez przystawke Uzytkownicy i komputery ustugi Active Directory (Active
Directory Users and Computers) . To witasnie tutaj skupione sg obiekty naszej domeny i tutaj bedziemy

nimi zarzadzac.

W systemie Windows Server 2008 R2 dostaniemy sie do tej przystawki wybierajac:

START -> Narzedzia Administracyjne (Administrative Tools) -> Uzytkownicy i komputery ustugi Active

Directory

W systemie Windows Server 2012 R2 dostaniemy sie natomiast wybierajac:

MENADZER SERWERA -> Narzedzia (Tools) -> Uzytkownicy i komputery ustugi Active Directory

Znajduja sie tam obiekty domysine, tworzone podczas instalacji samej ustugi:

= Active Directory Users and Computers [=[= |
‘Eie ,—':ﬁ: 7!|ew ,Eeb . . | File Action View Help
- == =
o Mo HD 383 Ta%R e 2m ooz BHm teuaTaR
—
- C“‘e' and Comput Na"s:\edQueres o ] Active Directory Users and Com|| Name Type Description
J J Vi L >
= 3 stkolalocal F3szkola.local Donain 3 Saved Queries Builtin builtinDomain
# (] Builtin 4 4 szkolalocal Computers  Container Default container for up...
Computers | Builtin

21 Domain Con... Organizational... Default container for do...
5| Domain Controllers

| ForeignSecurityPrincipals
_| Managed Service Accounts
| Users

Computers | ForeignSecu... Container Default container for sec...

31 Domain Controllers

3
3
3
b (] ForeignSecurityPrincipal:
2
b

#
@
@
- 1 Managed Se... Container Default container for ma...
+

| Users Container Default container for up...

Managed Service Accour|
| Users

Wbudowane grupy zabezpieczen (to te petnigce okreslone funkcje w systemie) przechowane
s w kontenerze Whbudowane (Builtin). Komputery, ktére pracuja w domenie, domysinie
przechowywane sg w kontenerze Komputery (Computers). Natomiast uzytkownicy oraz pozostate

typy grup w systemie znajdujg sie w kontenerze Uzytkownicy (Users).

Na obu wersjach systemu implementacja jednostek organizacyjnych,

uzytkownikow i grup jest doktadnie taka sama
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Zarzadzanie obiektami Active Directory 2017

W naszej domenie podziat bedzie nastepujgcy: uzytkownicy, ktérzy w systemie petnig role
administratorow, przechowywani bedg w kontenerze Uzytkownicy. Z kolei dla uzytkownikéw
domenowych, czyli wszystkich pozostatych uzytkownikdow w domenie utworzymy sobie specjalne
kontenery zwane jednostkami organizacyjnymi. llo$¢ jednostek organizacyjnych zalezy od struktury
organizacyjnej w danej firmie, przedsiebiorstwie czy szkole. Jednostki implementuje sie w taki sposdb,

aby odzwierciedlaty rzeczywistg sytuacje.

Utworzenie jednostek organizacyjnych:

PPM klikamy w nazwe domeny -> Nowy (New) -> Jednostka Organizacyjna (Organization unit) ->

nazwa jednostki -> OK

Domyslnie, ustawiona jest opcja zabezpieczajgca przed przypadkowym usunieciem jednostki. Jesli
podczas tworzenia jednostki opcje zostawili$cie aktywnga, a z jakichs powoddw chcielibyscie usungé

dang jednostke, mozna to zrobi¢ tak:

Widok (View) -> Funkcje zaawansowane (Advanced Features)

B Active Directory Users and Computers ] |

File  Action | wiew Help

4= $ | j.‘rJ| Add/Remove Columns... £ E ’k

: Active Direr Large Icons | Description |
| Savedt  5Small Icons . o
5 G5 stholal | List here are no items to show in this view.
J Buil = Detail
| Cor

=] Dor Users, Contacts, Groups, and Computers as containers
| For
~| Mar  Filter Options...

| Use
S| M=

HHEHEHBEA

Customize. ..

KN I 2

|Enab|esfdisables advanced features and objects
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Zarzadzanie obiektami Active Directory

| 2017

Klikamy PPM w jednostke, ktorg chcemy usungc -> Wtasciwosci (Properties)

B Active Directory Users and Computers 1Ol x|
File  Acton View Help
e 2 e e W ERENERET] ? oall -0 WV i Y
: Active Directory Users and Comput | Name | Type | Description |
|| Saved Queries [ Builtin builtinDomain
= .iz.l sz.knla.local || Computers Container Default container for upar...
TI Builtin |2| Domain Cont... Organizational ...  Default container for dom...
TI Comp.uters || ForeignSecur...  Container Default container for secu...
%I Domlaln Contrloller.s el Infrastructure  infrastructurel...
TI Eor:;gndSFecur:yPnnupa s | LostAndFound  lostAndFound Default container for arph...
+ ostAndFoun =
TI . || Managed Ser... Container Default container for man...
|_| Managed Service Accounts | — NTDS = DS taC i ficati £
[ Pragram Data J Quotas msl —Quo 0... Quota sped .ca ons cont...
[ System J Program Data  Container De:’ault location for storag...
= m— Lemtem Container Builtin system settings
%I Delegate Contral... . Oroanizational
[ Users " Friowie rganizational ...
7] NTDS G o:e... Ers Container Default container for upgr...
Find...
New 3
All Tasks 2
Cut
Delete
Rename
Help |
N 2
|Dpens the properties dialog box for the current selection, |
Zaktadka Zabezpieczenia (Security) -> Zaawansowane (Advenced)
B Active Directory Users and Computers -0l x|

File Acton View Help

T I GIENERE crovie Properties

: Active Directory Users and Com General I Managed Byl Object  Security
[ Saved Queries

Gmup Qr user names:

E 3 skola.local
| Builtin
Computers -Q:_,SELF
Domain Controllers -E!,Mhenticated Uszers
ForeignSecurityPrincipal .Q!‘SYSTEM

LostAndFound :?ﬂ_‘ Domain Admins {SZKOLA\Domain Admins)

FHEHEBEHEERBBGH
CLERDEERBRD

Managed Service Accou 52 Ertemrise Admins (SZKOLA\Ertemrise Admins) ll
Program Data
System fai | TEmE |
uCzZniowie
Users Pemissions for Everyone Allow Deny
NTDS Quotas Full control O O =
Read O O
Write O O |
Create all child objects O O
Delete all child objects O O -

For special permissions or advanced settings, click
Advanced.

Leam about access control and pemmissions

o]

Cancel | Apply |

]
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Zarzadzanie obiektami Active Directory | 2017

Zaznaczamy Wszyscy (Everyone) -> Usun (Remove)

R
File Action View Help
e[ 2m 00 CCEET— 20
= ™ Active Directory Users and Com General I Managed E‘)'l Object  Security ICOM+| Attribute Edrtorl
_| Saved Queries (T T T ——
= jéj szkola. local l Advanced Security Settings for uczniowie
| Builtin
~| Computers Pemissions | Audting | Owner | Effective Pemissions |
2 | Domain Controllers
| ForeignSecurityPrincpal To view or edit details for a permission entry, select the entry and then click Edit.
| LostAndFound
| Managed Service Accou Pemission entries:
| Program Data -
| System : Inherited From
3] uczniowie Everyone Special <niot inherited:
= Users B Allow Azcount Operators (SZK...  Create/delete Inet...  <not inherited:
~| NTDS Quotas Allow Account Operators (SZK...  Create/delete Com...  <not inherted: This ob]eu::t only
Allow Account Operators (SZK...  Create/delete Gro...  <not inherted: This object only
Allow Print Operators (SZKOLA. .. Create/delete Print...  <not inherted: This object only
Allow Azcount Operators (SZK...  Create/delete User... =<not inherted: This object only
Allow Domain Admins (SZKOL...  Ful control <not inherited: This object only
Allow ENTERPRISE DOMAIN ... Special <not inherted: This object only
E Allow Muthenticated Users Special <not inherted: This object only
A Allow SYSTEM Full contral <not inherted: This object only
Allman Dem WAL A manm WL T e C o] IR e PPN B o Tl PR | Ml At lm i Dmm LI
L
¥ Include inheritable pemissions from this object’s parent
KN I ]
| Managing permission entries
_ = = | = |

Teraz mozna juz usung¢ dang jednostke klikajgc PPM -> Usun. Czynno$¢ tg wykonujemy dla wszystkich

jednostek, ktére chcemy usunac.

W nowo utworoznej jednostce organizazcyjnej mozliwe jest tworzenie grup uzytkownikéw, samych

uzytkownikow, a takze obiektow komputerdw.

Tworzenie grup:

PPM w nazwe jednostki organizacyjnej (lub tez w samej jednostce) -> Nowy (New) -> Grupa (Group)

-> nazwa grupy -> okreslamy zakres (scope) oraz typ (type) grupy -> OK.

W systemach Windows Server mamy dostepne 3 zakresy grup:

> Lokalne w domenie (ang. Domain local) — grupy, do ktérych mozna doda¢ uzytkownikow z
kazdej domeny w lesie. Stosowane sg do nadawania uprawnien do katalogow.

> Globalne (ang. Global) — grupy, do ktérych mozna doda¢ uzytkownikéw z tylko jednej
domeny w lesie. Stosowane sg do nadawania uprawnien do katalogéw, a takze do
definiowania rél w systemie.

> Uniwersalne (ang. Universal) — grupy, do ktérych mozna doda¢ uzytkownikow z kazde;j
domeny w lesie. Stosowane sg do nadawania uprawnien do katalogéw, a takze do
definiowania rél w systemie.
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Zarzadzanie obiektami Active Directory 2017

A takze 2 typy grup:

> Zabezpieczen (ang. Security) — grupy pozwalajgce na nadawanie uprawnien do zasobdéw.
» Dystrybucyjne (ang. Distribution) — grupy stosowane do tworzenia list dystrybucyjnych
poczty elektroniczne;.

Tworzenie uzytkownikow:

PPM w nazwe jednostki organizacyjnej (lub tez w samej jednostce) -> Nowy (new) -> Uzytkownik

(User) -> Wprowadzamy imie, nazwisko, login -> Wprowadzamy hasto (dwukrotnie) -> OK.

Domyslnie hasto, ktére nadawane jest dla uzytkownika musi zawieraé co najmniej 7 znakdw i spetniaé
wymagania co do ztozonosci (mata, wielka litera, cyfra, znak specjalny). Pozostawienie tej opcji bez
zmian jest bezpiecznym rozwigzaniem poniewaz niweluje ryzyko stosowania fatwych do odgadniecia
haset przez uzytkownikéw. Jesli natomiast ktos chciatby to zmieni¢ moze to zrobic¢ postepujac, tak jak

w tym fragmencie wideo:

https://www.youtube.com/watch?v=11uuQiuM8v0&feature=youtu.be&t=22m51s

Dodawanie uzytkownikéw do grupy:

PPM w nazwe uzytkownika -> Dodaj do grupy (Add to group) -> wprowadzamy nazwe grupy -> OK
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Zadanie do samodzielnego rozwigzania 2017

Utwdrz nowy las oraz domene o nazwie firma.com
Ustaw diugosé haset dla uzytkownikéw w domenie na min. 4 znaki oraz wytacz ztozonos¢ tych
haset.
Podtgcz do domeny 2 komputery klienckie i nadaj im odpowiednio nazwy: STACJA1 oraz
STACJA2.
Utwoérz i skonfiguruj konta uzytkownikdw pracujgcych w domenie wg podanych zatozen:
4.1. Utworz jednostke organizacyjng o nazwie workers, a w niej:
4.1.1.Utwdrz konto Maria Sktodowska z loginem ksiegowy oraz hastem B456
4.1.2.Utwdrz konto Zofia Antonina z loginem kadrowy oraz hastem €789
4.2. Konta ksiegowy oraz kadrowy skonfiguruj tak, aby mozliwe byto logowanie od poniedziatku
do piatku w godzinach od 8:00 do 16:00, tylko na komputerze STACJAL.
4.3. Utworz jednostke organizacyjng o nazwie owners, a w niej:
4.3.1.Utwdrz konto Adam Stodowy z loginem wlasciciel oraz hastem A123
Na serwerze w katalogu gtéwnym dysku C, zatdz folder dane, udostepnij go w sieci pod nazwa
dane i zabezpiecz wg zatozen:
5.1. konta wlasiciel oraz ksiegowy majq miec petne prawa dostepu,
5.2. konto kadrowy ma mie¢ prawo tylko do odczytu.
Na serwerze w katalogu gtéwnym dysku C zatéz folder profil, udostepnij go w sieci pod nazwa
profil i zabezpiecz wg zatozen:
6.1. konto wlasiciel ma prawa do odczytu i zapisu.
Dla uzytkownika kadrowy, ustaw automatyczne mapowanie udostepnionego folderu pod litere
X.

Dla uzytkownika wilasciciel skonfiguruj profil mobilny.



